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�����1 About this manual

This reference manual is for installation technicians and operators of the C-Band 
5760/5712H and Ku-Band 5940 SSPAs.

This manual contains the following sections:
Chapter 1 About this manual�lists all terms, abbreviations and units used in this 

manual
Chapter 2 Electromagnetic compatibility and safety notices�describes how to ensure 

CE compliance of the SSPAs is maintained
Chapter 3 Overview�contains a general description of the SSPAs and their controls
Chapter 4 Specifications�contains the specifications for the SSPAs
Chapter 5 How the SSPAs work�provides a brief technical description of how the 

SSPAs work
Chapter 6 Installation and setup�describes how to install the SSPAs and the safety 

precautions that must be taken
Chapter 7 Operating the SSPA�describes how to operate the SSPAs
Chapter 8 Operating the SSPA remotely�describes how to operate the SSPAs 

remotely
Chapter 9 Maintenance and fault finding�describes how to maintain the SSPAs, and 

the possible causes of alarms and faults
Chapter 10 Drawings�contains the drawings referred to in the manual
Appendix A Summary of parameters controlled by the SSPA Manager software�

contains a summary of the parameters that are monitored and controlled by 
the SSPA Manager software

Appendix B SSPA Manager screens�contains the screens from the SSPA Manager 
software that show full functionality

An index can be found at the end of this manual.
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About this manual
Standards and icons
The following standards and icons are used in this manual:

This typeface Means...

BOLD/Bold a button, key, switch, connector or displayed text

Bold times text that is typed in as a command, or the name of a key on a 
computer�s keyboard

Italics a cross-reference or text requiring emphasis

This icon Means...

1 a step to follow

WARNING your actions may cause harm to yourself or the equipment

CAUTION proceed with caution as your actions may lead to loss of data, privacy 
or signal quality

NOTE the text provided next to this icon may be of interest to you
2 C-Band and Ku-Band Hub-mount SSPAs 5760/5712H and 5940 Reference Manual



About this manual
Definitions

Acronyms and abbreviations

This term Means...

AC alternating current

AM/PM amplitude modulation to phase modulation

ASCII American standard code for information interchange

AUX auxiliary

Comms communications

Comp/COMP compensation

CTS clear to send

CW continuous wave, carrier wave

DC direct current

EEPROM electronically erasable programmable read only memory

EMC electromagnetic compatibility

FET field effect transistor

GaAs Gallium Arsenide

GCP gain compression point

Gnd ground

IF intermediate frequency

LCL local (mode)

LLO local lockout (mode)

Maint maintenance

MAX maximum

N/C not connected

NC normally closed

NO normally open

OPBO output back off

PA power amplifier

PFC power factor correcting
C-Band and Ku-Band Hub-mount SSPAs 5760/5712H and 5940 Reference Manual 3



About this manual
Glossary

PIN P-type intrinsic N-type

P�P peak to peak

R&TTE radio and telecommunications terminal equipment

REM remote (mode)

RF radio frequency

RLO remote lockout (mode)

RMA return materials authorisation

RTS ready to send

Rx receive

SSPA solid state power amplifier

Tx transmit

UART universal asynchronous receiver/transmitter

This term Means...

Firmware Software that is embedded within the SSPA.

This term Means...
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About this manual
Units

Unit multipliers

Measurement Unit Abbreviation

Attenuation decibel dB

Current ampere A

Data rate bits per second bps

Distance metre m

Frequency hertz Hz

Impedance ohm Ω

Mass gram g

Noise temperature kelvin K

Power decibels relative to a carrier dBc

Power decibels relative to 1 mW dBm

Power watt W

Temperature degrees Celsius °C

Time hour hr

Time second s

Voltage volt V

Unit Name Multiplier

n nano 10�9

µ micro 10�6

m milli 10�3

d deci 10�1

k kilo 103

M mega 106

G giga 109
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About this manual
About this issue
This is the second issue of the C-Band and Ku-Band Hub-mount SSPAs 5760/5712H and 
5940 Reference Manual covering the CE compliance regulations introduced in 
April 2001.

Associated documents

The associated documents are:

� High Power SSPA Redundancy Switching Equipment Reference Manual (Codan 
part number 15-44015-EN)

� C-Band Transceiver 5700 series Reference Manual (Codan part number 
15-44001-EN)

� Ku-Band Transceiver 5900 series Reference Manual (Codan part number 
15-44005-EN) 
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2 Electromagnetic compatibility and safety 
notices

This section describes how to ensure the C-Band 5760/5712H and Ku-Band 5940 SSPAs 
comply with the Radio and Telecommunications Terminal Equipment Directive 
1999/5/EC.

The C-Band 5760/5712H and Ku-Band 5940 SSPAs have been tested and comply with 
the following standards:

� ETSI EN 301 428 V1.2.1 (2001�02) �Satellite Earth Stations and Systems (SES); 
Harmonized EN for Very Small Aperture Terminal (VSAT); Transmit-only, 
transmit/receive or receive-only satellite earth stations operating in the 
11/12/14 GHz frequency bands covering essential requirements under article 3.2 of 
the R&TTE directive� (5940 only)

� ETSI EN 301 443 V1.2.1 (2001�02) �Satellite Earth Stations and Systems (SES); 
Harmonized EN for Very Small Aperture Terminal (VSAT); Transmit-only, 
transmit/receive or receive-only satellite earth stations operating in the 4 GHz and 
6 GHz frequency bands covering essential requirements under article 3.2 of the 
R&TTE directive� (5760/5712H only)

� ETSI EN 301 489-1 V1.2.1 (2000�08) �Electromagnetic compatibility and Radio 
spectrum Matters (ERM); ElectroMagnetic Compatibility (EMC) standard for radio 
equipment and services; Part 1: Common technical requirements�

� ETSI EN 301 489-12 V1.1.1 (2000�12) �Electromagnetic compatibility and Radio 
spectrum Matters (ERM); ElectroMagnetic Compatibility (EMC) standard for radio 
equipment and services; Part 12: Specific conditions for Very Small Aperture 
Terminal, Satellite Interactive Earth Stations operated in the frequency ranges 
between 4 GHz and 30 GHz in the Fixed Satellite Service (FSS)�

� EN 60950 (�Safety of Information Technology Equipment, including electrical 
business machines�, 2000)

Compliance with these standards is sufficient to fulfil the requirements of the Radio and 
Telecommunications Terminal Equipment Directive 1999/5/EC, which encompasses the 
following directives:

� European EMC Directive, 89/336/EEC

� European Low Voltage Directive, 73/23/EEC with no lower voltage limit

Equipment supplied by Codan that satisfies these requirements is identified by the 
 markings on the model label of the product.

NOTE

Some countries may restrict the use of satellite communications 
equipment on certain frequency bands or require such equipment to be 
licensed. It is the user�s responsibility to check the specific requirements 
with the appropriate communications authorities.

����
C-Band and Ku-Band Hub-mount SSPAs 5760/5712H and 5940 Reference Manual 7



Electromagnetic compatibility and safety notices
Complying with the European Radio and Telecommunications Terminal 
Equipment Directive

Electromagnetic compatibility

To ensure compliance with the EMC Directive is maintained, you must ensure the covers 
for the equipment are correctly fitted.

Electrical safety

To ensure compliance with the European Low Voltage Directive is maintained, you must 
install the C-Band 5760/5712H and Ku-Band 5940 SSPAs in accordance with the 
following safety precautions. These precautions must be checked before applying power 
to the SSPA.

Radiation safety

Spurious emissions

The waveguide filter (Codan part number 14-0465) must be fitted to the output of the 
5760 and 5712H SSPAs to ensure compliance with the spurious emission requirements 
of the European R&TTE Directive.

CAUTION If it is necessary to remove the covers at any stage, they must be refitted 
correctly before using the equipment.

WARNING An earth connection must be included in the mains wiring to the SSPA 
(see page 9, Earth symbols).

WARNING
As the SSPA is intended for permanent connection to the mains supply, a 
readily accessible switch or circuit breaker must be incorporated in the 
mains wiring to enable easy isolation of the unit.

WARNING
The isolating switch must disconnect both poles simultaneously. 
However, if you can positively identify the neutral conductor, you may 
have a single-pole isolating device in the live conductor.

WARNING Do not look into the unterminated output of the SSPA or point it towards 
anyone.

WARNING Always fit the correct termination to the SSPA or fit the blanking plate.
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Electromagnetic compatibility and safety notices
Earth symbols

Earth connection points have been provided on the SSPA. To comply with the European 
Low Voltage Directive, the symbols shown in Table 1 are used to identify the earths on 
the equipment.

Warning label

The symbol shown in Table 2 is used to identify potential hazards on the equipment. 

Table 1: Earth symbols

Symbol Meaning

Chassis earth

Protective earth

Table 2: Warning label

Symbol Meaning

Non-ionising radiation 
may be emitted��
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�����3 Overview

This section describes the features of the C-Band 5760/5712H and Ku-Band 5940 SSPA 
modules.

The SSPAs provide high performance together with compact size, rugged construction 
and optimum thermal characteristics. Innovative RF power combining technology, the 
latest GaAs FET devices and surface-mount technology are used. Remote operation of 
all control and status functions is possible via a serial interface.

The SSPAs feature an output isolator for operation into any load. The RF output power 
and FET flange temperature are continuously monitored. Alarm thresholds can be set for 
low or high power and the gain of each SSPA is adjustable over a 20 dB range. Gain 
variation versus temperature is automatically compensated in firmware.

Modular construction is used throughout. The comprehensive monitoring functions 
facilitate rapid field troubleshooting. No regular maintenance is required on the unit.

The SSPAs are designed to be mounted outdoors on the antenna pedestal.

This description should be read in conjunction with the drawings on page 79, Drawings. 
Drawing 0969D22 provides a complete visual description of the C-Band SSPAs. 
Drawing 0969D23 provides a complete visual description of the Ku-Band SSPA. The 
drawings also show connector designations. The unit has two external fans for cooling 
the RF modules of the SSPA and the power supplies.
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�����4 Specifications

This section contains the following topics:

Electrical (14)

General (16)

Environmental (17)

Physical (17)
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Specifications
Electrical

Frequency band

5760/5712H 5.850 to 6.425 GHz

5940 14.0 to 14.5 GHz

Output power @ 25°C

5760 +47.8 dBm typical at saturation
+47.0 dBm minimum at 1 dB GCP

5712H +50.8 dBm typical at saturation
+50.0 dBm minimum at 1 dB GCP

5940 +46.5 dBm minimum at saturation
+46.0 dBm minimum at 1 dB GCP

Third order intermodulation products (two carriers each at 6 dB below 1 dB GCP)

5760 �26.0 dBc maximum

5712H �26.0 dBc maximum

5940 �25.0 dBc maximum

Gain

Gain at 0 dB gain setting
5760/5712H
5940

65 dB minimum
60 dB minimum

Gain variation over band ±1 dB maximum

Gain variation over any 
40 MHz band

±0.3 dB maximum

Gain stability over 
�40 to +55°C

±1.5 dB maximum

Gain adjustment 0 to �20 dB in 0.2 dB steps
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Specifications
Maximum input power (at maximum gain)

5760 �15.0 dBm

5712H �12.0 dBm

5940 �12.0 dBm

Output noise power

5760/5712H �90 dBm/Hz maximum

5940 �82 dBm/Hz maximum

AM/PM conversion (at 
1 dB OPBO from 1 dB 
GCP)

2°/dB maximum

Harmonics (at rated output power)

5760/5712H �50 dBc maximum

5940 �50 dBc maximum

Group delay (over 40 MHz)

Linear 0.03 ns/MHz

Parabolic 0.003 ns/MHz2 

Ripple 1 ns P�P

VSWR

Input 1.3:1 minimum

Output 1.25:1 minimum
C-Band and Ku-Band Hub-mount SSPAs 5760/5712H and 5940 Reference Manual 15



Specifications
General

Protection Input and output isolators
Overtemperature shutdown

Monitor and control

Monitor and control RF power meter
RF monitor @ �41 dBc nominal
FET flange temperature
ON/OFF control

Summary alarm Overtemperature
FET failure
Low/High RF power

Alarm logic levels Dry contacts

Serial interface RS232
RS422/RS485

Data rate 9600 bps

Data format 8 bits, no parity, 1 stop bit

Power supply

5760 115 VAC, 7.1 A (60 Hz) or
230 V AC, 3.6 A (50 Hz)

5712H 115 VAC, 11.3 A (60 Hz) or
230 V AC, 5.6 A (50 Hz)

5940 115 VAC, 8.0 A (60 Hz) or
230 V AC, 4.0 A (50 Hz)

DC outputs

Main
Auxiliary

�48 V DC 

�48 V DC
75 W maximum, 1.5 A (total)
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Specifications
Environmental

Physical

Connectors

RF input N-type female 50 Ω

RF output
5760/5712H

5940

CPR137-G waveguide flange
(M5 × 8 mm deep, 8 places)
PBR120 grooved waveguide flange (WR75)
(M4 × 8 mm deep, 4 places)

RF monitor N-type female 50 Ω

AC input Amphenol T3110 000

Control MS3114E14-19P

Serial MS3114E14-19S

�48 V DC main output MS3114E8-2S

�48 V DC auxiliary output MS3114E8-2S

Operating environment

Operating temperature �40 to +50°C

Relative humidity 100%

Cooling Fan forced

Maximum operating altitude 3000 m above sea level

Mechanical

Size 277 mm W × 354 mm D × 491 mm H

Weight 27 kg

Sealing To IP66
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�����5 How the SSPAs work

The input signal is amplified by a variable gain driver module. The driver module uses 
PIN diode attenuation for gain control and temperature compensation driven by the 
SSPA microcontroller. The driver module FET current is monitored and, if any FET fails 
and the total current falls outside acceptable limits, an alarm is indicated.

The amplified signal feeds the final power module. The power module consists of a 
cascade of single-ended stages. The 5760 SSPA has two parallel power stages. The 
5712H and 5940 SSPAs have four parallel power stages. The outputs of these power 
stages are combined as required, then routed to the output via a waveguide isolator and 
monitor.

The current drawn by each of the power FETs is continuously monitored and if the 
current to any device falls outside acceptable limits, an alarm is indicated.

If the input voltage to the power module exceeds a preset limit, or the FET flange 
temperature increases above about 105°C (C-Band) or 85°C (Ku-Band), an alarm is 
indicated.

A monitor/detector unit is provided at the output for monitoring the RF output level. The 
detector output feeds the microcontroller to allow the RF output level to be read via the 
serial interface. The RF monitor output feeds a connector to allow the SSPA output to be 
monitored on a spectrum analyser or power meter.

The RF power monitor operates as an average power monitor, i.e. the voltage indication 
is the same for both CW and modulated signals.

The SSPA power supply incorporates:

� a PFC AC�DC converter

� a DC�DC converter providing the main PA supply

� magnetic amplifiers providing auxiliary DC supplies

The PFC front end converts the AC mains to a nominal 400 V DC bus.

The DC�DC converter converts the 400 V DC bus to the low voltage, high current 
supply required for the power amplifier.

The auxiliary DC supplies for the microcontroller system, analog support circuitry, 
cooling fans and the 48 V supply are derived from the main DC�DC converter via the 
magnetic amplifiers.

The power supply temperature is also monitored, and when the temperature is too high, 
an alarm is indicated.
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�����6 Installation and setup

This section contains the following topics:

Unpacking the SSPA (22)

Installing the SSPA (23)

Grounding recommendations (25)

Welding precautions (26)

Safety precautions (27)

Power supply connections (28)

Interface connections (29)

Installing the SSPA Manager software (34)

Setting up the SSPA (35)
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Installation and setup
Unpacking the SSPA
Ensure that the packing boxes containing the equipment are upright, as indicated by the 
printing on the boxes. Open each box and examine the contents for signs of damage. If 
damage is detected, contact Codan immediately to obtain an RMA before returning the 
equipment. Failure to do so may result in any warranty being void.

The SSPA is shipped with a mounting kit.

Remove the SSPA and its mounting kit from the packaging.

Check that the mounting kit provided has:

� four Unistrut bars

� four threaded rods

� miscellaneous screws, nuts and washers

A blanking plate is attached to the output waveguide flange of the SSPA. This blanking 
plate should be removed before installing the SSPA in your system. If the SSPA needs to 
be shipped for any reason, the blanking plate must be re-attached to the SSPA.
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Installation and setup
Installing the SSPA

Mounting the SSPA

The SSPA is designed to be mounted on the antenna post. A suggested mounting 
arrangement for the C-Band and Ku-Band SSPAs using the mounting kit supplied is 
shown in drawing 0969D46.

The SSPA power supply can operate with any AC input voltage in the range 104 to 
274 VAC.

Connecting the SSPA

To connect the SSPA:

1 Connect the AC power lead (Codan part number 04-0969A-12) to the AC mains 
supply.

1 Ensure the isolating switch for the AC supply is switched off.

1 Connect the AC power lead to the plug on the bottom of the SSPA.

1 Connect the RF coaxial cable from the Tx RF O/P connector on the converter to the 
RF Input connector on the SSPA.

1 Using appropriate waveguide sections, connect the SSPA RF output to the antenna 
transmit port.

WARNING Voltages outside of these limits may cause damage to the SSPA.

NOTE For details on the power supply connections see page 28, Power supply 
connections.

WARNING You must check that the AC supply has a proper ground connection 
before connecting the unit to the mains supply.

WARNING Observe AC supply precautions (see page 8, Electrical safety).

WARNING

The positive terminal of the �48 V supply is grounded. Any 
equipment using the supply should either be fully floating or operate 
with the same polarity. Failure to observe this precaution may result 
in damage to the �48 V supply.

WARNING Use appropriate waveguide gaskets to ensure all waveguide joints are 
sealed (see below, Gasket kits).

NOTE Ensure that the RF MONITOR port is terminated with the supplied 
50 Ω termination when it is not in use.
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Installation and setup
1 Tape all connectors with self-amalgamating tape.

1 Check that all fans are unobstructed and operating correctly.

Gasket kits

Table 3 lists the gasket kits available from Codan for C-Band and Ku-Band equipment.

NOTE
With C-Band equipment, a half gasket is used when mating a grooved 
flange with a flat flange. A full gasket is used when mating two grooved 
surfaces.

NOTE

With Ku-Band equipment, a thin gasket is used when mating a shallow 
groove (0.050") with a flat flange. A thick gasket is used when mating a 
deep groove (0.080") with a flat flange.

All Codan Ku-Band SSPAs have shallow groove flanges.

Table 3: Gaskets kits for C-Band and Ku-Band equipment

Codan part number Name Contents of kit

C-Band equipment

15-40095 Flange kit WR137 half gasket, 25 mm screws and nuts

15-40096 Flange kit WR137 full gasket, 25 mm screws and nuts

15-40097 Flange kit WR137 half gasket, 16 mm screws, no nuts

15-40098 Flange kit WR137 full gasket, 16 mm screws, no nuts

15-40123 Flange kit WR137 full gasket, 12 mm screws, no nuts

Ku-Band equipment

15-40173 Thin gasket kit Thin gasket, 10, 12 and 16 mm M4 screws and nuts

15-40172 Thick gasket kit Thick gasket, 10, 12 and 16 mm M4 screws and nuts

15-40174 Universal gasket kit Thin and thick gaskets with a variety of screws and nuts
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Installation and setup
Grounding recommendations

These potential differences may occur:

� if there is a fault in the AC mains reticulation system

� when high power electrical machinery located nearby is switched on or off

� if a lightning strike occurs in the area

It is highly recommended that the antenna metal structures and the cases of the outdoor 
equipment be connected together and grounded with earth stakes, or in the case of 
rooftop sites, be connected to the lightning grid and earth system of the building. The 
earth screws on the SSPA modules are provided specifically to provide this protection. 

In the case of lightning strikes, huge ground currents occur for several hundred metres 
around a strike area, causing large voltage potentials between separate earth points. For 
this reason, some lightning engineers recommend the use of large copper earth straps (or 
braid) to connect the indoor and outdoor equipment earth systems.

WARNING
Precautions must be taken to ensure the installation is adequately 
protected against voltage potential differences that may occur between the 
outdoor and indoor equipment.

WARNING For critical installations in lightning-prone areas, it is strongly advised 
that you seek expert advice on lightning protection.

CAUTION The SSPA must be earthed via its chassis earth to ensure CE compliance.
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Installation and setup
Welding precautions
When arc welding on or near the antenna structure, take the following precautions to 
minimise the danger of large welding currents flowing through the communications 
cables:

1 Disconnect all cables from the indoor equipment, including power, control and IF 
cables.

1 Disconnect all cables between the SSPA and any other equipment.
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Safety precautions
Before switching the SSPA on, these safety precautions must be taken.

Moisture protection

Radiation warning

The SSPA is capable of both high gain and high power. If it has not been terminated 
correctly, the SSPA could emit high levels of non-ionising radiation from its waveguide 
output when activated due to oscillation caused by feedback.

Power supply

Regardless of the AC supply connected, the power supply unit in the SSPA produces an 
internal DC voltage of about 400 V DC.

WARNING The SSPA case is not designed to be opened in the field. Any moisture 
inside the cabinet may damage the SSPA.

WARNING Ensure all connectors have either their protective caps fitted or are taped 
with self-amalgamating tape.

WARNING Do not look into the unterminated output or point it towards anyone.

WARNING
Ensure the output waveguide port of the SSPA is either connected to the 
antenna feed or terminated with a high power load before operating the 
SSPA.

WARNING
When the SSPA is in Standby mode it is not muted and can still generate 
RF output power. You must mute the SSPA if you want to prevent 
transmission.

WARNING The DC voltage inside the SSPA can be lethal. Do not operate the SSPA 
with the covers removed.
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Installation and setup
Power supply connections

SSPA AC mains supply

Table 4 lists the pin connections and provides a description of input functions available 
on the AC INPUT connector.

�48 V DC output connectors

There are two �48 V DC OUTPUTS connectors on the SSPA.

Table 5 lists the pin connections and provides a description of output functions available 
on the �48 V DC OUTPUTS connectors.

Table 4: AC input connector pinouts (Amphenol T 3110 000)

Pin Description

1 Neutral

2 Not connected

3 Active

Protective earth

Table 5: �48 V DC outputs connectors pinouts (MS3114E8-2S)

Pin Description

A 0 V

B �48 V DC
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Interface connections
The status and parameters of the SSPA can be controlled by a serial interface. Alarms 
and other SSPA functions are controlled by a control interface. The interface connections 
are provided via the CONTROL and SERIAL connectors on the SSPA.

Control interface

The Control interface may be set to either generic mode or to specifically drive the 
Codan 5700/5900 converter. This setting is accessed using the SSPA Manager software.

The interface connections to a 5700 or 5900 Converter are shown in Figure 1. The 
converter is powered by the �48 V DC output from the SSPA.

Figure 1: Connection diagram for C-Band or Ku-Band transceiver

Table 6 lists the pin connections for the control interface and provides a description of 
input/output functions available on the CONTROL connector. All relay contacts are fail 
safe, i.e. the relay is de-energised in alarm state. The descriptions shown are only 
applicable when the SSPA control interface is set to generic mode.
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Installation and setup
Table 6: Control connector pinouts (MS3114E14-19P) 

Pin Type Name Description

A Output Sw Drive +11 V supply output, which may be used to 
drive internal opto couplers.

B Output Urgent (NO) Normally open contact of the Urgent Alarm 
relay, i.e. open when an urgent alarm condition 
is present.

C Output Maint 
(Overtemp)

Normally open contact of the Maintenance 
relay, i.e. open when the SSPA is indicating an 
overtemperature condition.

D GND Signal ground.

E Output Alarm Normally open contact of the Summary Alarm 
relay, i.e. open when an alarm condition is 
present.

F Output Sw Out (NO) Normally open contact of the Switchover Out 
relay, i.e. open when the SSPA is in the standby 
state.

G N/C

H N/C

J N/C

K Input Clr In A low on the Clear Alarms input clears any 
latched alarms that are no longer active. The 
minimum low time is 10 ms.

L Input Control Com An external +11 V input that is common to pins 
P, N, V and K. Connected internally to Pin A.

M In/Out Contact Com Common contact for pins B, C and E. This pin 
is connected to ground.

N Input PA Act Ignored in generic mode.

P Input Sw In Used to control switchover in redundancy 
SSPA systems. SSPA goes to standby if pulled 
low (> 20 ms).
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The control interface input levels and relay outputs are defined in Table 7 and Table 8.

 

R In/Out Sw Out (Com) Common contact of the Switchover Out relay. 
This pin is connected to ground.

S In/Out Sw Out (NC) Normally closed contact of the Switchover Out 
relay, i.e. closed when the SSPA is in the 
standby state.

T N/C

U Input Mute A low will cause the internal mute facility to 
activate, muting the RF output of the SSPA. A 
high will restore the RF output. This input 
overrides the unmute command from the serial 
interface.

V Input Aux In Auxiliary Alarm input for use with external 
equipment. A connection to ground (default) 
will cause an alarm condition. This can also be 
active high depending upon the setting in the 
SSPA Manager.

Table 7: Control interface levels

Control signal Level

Sw In
Mute In
Aux In
Clr In

Contact closure to Contact 
Common

10 mA typical

PA Act Contact Closure to Contact 
Com

< 1 mA

Table 6: Control connector pinouts (MS3114E14-19P) (cont.)

Pin Type Name Description
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Table 8: Relay output definitions

Relay output definition Level

Type Dry contact, isolated

Maximum current 100 mA

Maximum voltage (to 
ground)

50 V

Operate time 3 ms maximum
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Serial interface

The C-Band 5760/5712H and Ku-Band 5940 SSPAs can be set up via their serial 
interface using a PC running the SSPA Manager software. See page 60, Remote 
communications protocol for details of how to communicate with the SSPA remotely via 
the serial interface.

Table 9 lists the pin connections for the serial interface and provides a description of the 
input/output functions available on the SERIAL connector.

Table 9: Serial connector pinouts (MS3114E14-19S) 

Pin Type Name Description

A N/C

B N/C

C N/C

D Ground GND Signal ground.

E � Termination 1 A link across these pins terminates the 
RS422/485 bus.F � Termination 2

G Output RS232 RTS RTS for RS232.

H Output RS232 TxD Transmit data for RS232.

J Input RS232 RxD Receive data for RS232.

K N/C

L N/C

M N/C

N N/C

P Input RS422/485 
RxD+

Receive data+ for RS422/485.

R Input RS422/485 
RxD�

Receive data� for RS422/485.

S Output RS422/485 
TxD+

Transmit data+ for RS422/485.

T Input RS232 CTS CTS for RS232.

U N/C

V Output RS422/485 
TxD�

Transmit data� for RS422/485.
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Installing the SSPA Manager software

System requirements

Software requirements

You must have Microsoft Windows 95 (or later) operating system installed on your PC.

Hardware requirements

To use SSPA Manager, the following PC hardware is required:

� 1 RS232 serial communication port for connecting to an SSPA

� CD ROM drive to load software

� approximately 5 MB hard disk space

Installing the software

To install the software:

1 Insert the Codan SSPA Manager CD into the CD drive of your PC.

1 If the CD does not autostart, use Windows Explorer to navigate to the CD drive of 
your PC, then double click on the setup.exe file.

1 Follow the prompts in the installation wizard to complete the installation.

Connecting a PC to the SSPA

To connect a PC to the SSPA:

1 Connect the serial cable (Codan part number 08-05301-002) from the 9-way D-type 
female connector on the PC to the SERIAL connector on the SSPA.

Details of the wiring of this cable are shown in drawing 08-05301. If connection to a 
25-way D-type serial port is required, use a standard 25-way female to 9-way male 
adaptor.

The connection may be permanent as part of the installation, or temporary, just for the 
purpose of setting the operating parameters of the SSPA.
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Setting up the SSPA 
To set up the SSPA in the system:

1 Switch on the AC supply to the SSPA.

1 Start the SSPA Manager software.

Setting SSPA parameters

To set the parameters:

1 In the SSPA Manager window, set up the following parameters:

1 In the SSPA Manager window, select SSPA Settings from the Options menu, then 
select the Standard tab.

1 Set the type of converter to Codan or Generic to suit your system.

1 Click Close.

1 Feed an RF signal into the SSPA at �30 dBm and connect a suitably rated power 
meter to the SSPA output of the RF MONITOR port.

1 In the SSPA Manager window, set the SSPA to Online and RF On, then adjust the 
RF gain using the Gain Adjust field to set the required output power level.

Parameter Setting

User Mute Setting RF Mute

Operating State Standby

Gain Adjust �20 dB

WARNING Significant damage to and possible failure of the SSPA may result 
from driving the SSPA beyond the rated output power.
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�����7 Operating the SSPA

This section contains the following topics:

Switching on the SSPA (38)

Switching off the SSPA (40)

Operating the SSPA using the SSPA Manager software (41)

Recording the setup of your SSPA (58)
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Operating the SSPA
Switching on the SSPA
To switch on the SSPA:

1 Switch on the AC supply to the SSPA.

If for any reason the non-volatile memory is corrupted during operation, the SSPA 
reverts to the factory default settings. A summary of the factory default settings is 
given in Table 10.

NOTE

The SSPA has non-volatile memory, so previous configurations and 
settings are maintained while the power is switched off. Default 
settings are present in non-volatile memory when the SSPA is 
shipped from Codan.

CAUTION Do not switch the unit off during the update period as this may 
corrupt the non-volatile memory.

Table 10: Factory default settings for the SSPA 

Setting Factory default

Alarm style Latched

Amplifier shutdown mode On

Audible alarm On

Auxiliary alarm sense Active low

Comms parameters 8 bits, no parity, 1 stop bit

Control interface mode Generic

Data rate 9600 bps

EEPROM storage On

Gain Adjust 0.0 dB

Maximum RF threshold Disabled

Minimum RF threshold Disabled
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Operating the SSPA
PIN diode table Single PIN diode

(0, 0), (1, 11), (2, 17), (3, 21), (4, 25), (5, 29), (6, 33), 
(7, 37), (8, 40), (9, 44), (10, 48), (11, 51), (12, 55), 
(13, 59), (14, 63), (15, 67), (16, 71), (17, 75), (18, 79), 
(19, 84), (20, 89), (21, 94), (22, 100), (23, 105), (24, 111), 
(25, 117), (26, 123), (27, 130), (28, 138), (29, 145), 
(30, 153), (31, 161), (32, 169), (33, 178), (34, 187), 
(35, 197), (36, 208), (37, 219), (38, 232), (39, 244), 
(40, 255)

Dual PIN diode

(0, 0), (1, 15), (2, 32), (3, 40), (4, 48), (5, 59), (6, 64), 
(7, 74), (8, 81), (9, 89), (10, 100), (11, 107), (12, 122), 
(13, 133), (14, 146), (15, 166), (16, 179), (17, 204), 
(18, 230), (19, 242), (20, 255), (21, 15), (22, 32), (23, 40), 
(24, 48), (25, 59), (26, 64), (27, 74), (28, 81), (29, 89), 
(30, 100), (31, 107), (32, 122), (33, 133), (34, 146), 
(35, 166), (36, 179), (37, 204), (38, 230), (39, 242), 
(40, 255)

RF level calibration table Linear curve (0.5 dB/1 V step) with rated power output at 
10 V; 20 dB below rated power output at 0 V

RF level temperature 
compensation

(6°C, Disabled), (50°C, Disabled), (88°C, Disabled)

RF mute Off

State Standby

Temp compensation 
calibration table

All 0°C and disabled

Temperature compensation Off

Thermal fan control Off

Unit address 0

Table 10: Factory default settings for the SSPA (cont.)

Setting Factory default
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Switching off the SSPA
To switch off the SSPA:

1 Switch off the AC supply to the SSPA.
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Operating the SSPA using the SSPA Manager software
The SSPA can be controlled using a PC and the Codan SSPA Manager software. This 
software provides monitor and control facilities for the parameters listed in Table 17 on 
page 81. It provides an alarm when values exceed the set operating range of the SSPA.

All control functions of the SSPA described in the following sections assume that:

� the SSPA is on

� a connection exists between the SSPA and the PC

� the SSPA Manager software is running

The following sections describe the full functionality of the SSPA Manager software. 
Some aspects of the software may not be available with your particular SSPA, depending 
on its hardware configuration or type.

Changes to settings that are made in the following ways are applied immediately:

� selecting from the drop list

� using the scroll buttons

� using the and keys on the keyboard when the field has focus

Changes to settings that are made by entering text into a field are applied by pressing 
Enter. Changes to text fields are discarded by closing the window, changing the focus to 
another tab within the open window, or by pressing Esc.

The SSPA Manager software may be operated without a mouse.

A summary of the SSPA Manager screens showing full functionality is included on 
page 85, SSPA Manager screens.
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Setting up communications

Setting up parameters for a PC

To set the serial communications parameters for a PC:

1 In the SSPA Manager window, select Software Options from the Options menu.

1 Select the Communications tab.

1 In the Port frame, select the Com port on the PC that is connected to the SSPA.

1 Select the serial communication option.

1 Set up the following communication parameters:

1 If you have selected the RS232 serial communication option, set the flow control 
setting to None.

Option Description

RS232 Normal setting

RS422/485 Used when the PC is fitted with an RS422/485 serial 
interface card and cable or external adaptor

NOTE The RS232 and RS422/485 interfaces are on separate pins on the 
SERIAL connector.

Parameter Setting

Data rate 9600 bps

Data bits 8

Parity None

Stop bits 1

Option Description

None No feedback is provided by the SSPA on the state of its 
input buffers
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1 If you have selected the RS422/485 serial communication option, set the half duplex 
control that you want to use.

1 Click OK.

Connecting to an SSPA

To connect to an SSPA:

1 In the SSPA Manager window, Communications Connection frame, set the address 
of the SSPA attached to the PC.

If you do not know the address of the SSPA to which you are connected, set the 
address to 0.

1 Click Connect.

Option Description

None/Auto Used when the attached interface card or external 
adaptor has its own duplex control, or if a full duplex 
connection is in place

RTS Used when the attached interface card or external 
adaptor requires a half duplex control signal for data 
transmission to the PC

CAUTION The broadcast address 0 cannot be used with an RS485 bus if there is 
more than one device on the bus.
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Using the basic settings

Selecting the operating state

The SSPA has three operating states:

� online

� standby

� maintenance (see page 55, Selecting Maintenance mode)

The usual operating state is on line.

Selecting Online mode

To switch the SSPA to Online mode:

1 In the SSPA Manager window, select the Online option in the Operating State frame.

You will not be able to switch the SSPA to Online mode if it has an urgent fault 
present (see Table 13 on page 72). If an urgent fault has occurred:

� the Standby option in the Operating State frame will be selected

� the field in the Alarms frame will be flashing red

Selecting Standby mode

To switch the SSPA to Standby mode:

1 In the SSPA Manager window, select the Standby option in the Operating State 
frame.

NOTE If certain faults are detected during operation, the SSPA switches to 
standby.

WARNING
Standby mode does not automatically place the SSPA into an RF mute 
state. The SSPA will only be automatically muted if it has switched to 
Standby mode due to the failure of a module.
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Setting the RF gain

To set the RF gain:

1 In the SSPA Manager window, RF Output frame, set the gain that you want to use in 
the Gain Adjust field.

The RF gain can be set in increments of 0.2 dB.

As the RF gain is adjusted, the output power will change. This is indicated by a 
change in the RF level as shown in the RF Level field.

Setting the mute status

To set the mute status:

1 In the SSPA Manager window, User Setting frame, select the mute status that you 
want to use.

The mute state of the SSPA is shown in the SSPA Mute State frame.

Option Description

RF On SSPA is unmuted and able to transmit if not externally 
muted

RF Mute SSPA is muted with no RF output

State Description

RF On SSPA is unmuted

RF Mute (User) SSPA is muted by the user

RF Mute (Direct I/O) SSPA is muted by a contact closure input signal in the 
CONTROL connector

RF Mute (Amp 
Module Fail)

SSPA is muted due to a driver module or power amplifier 
module fault
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Viewing the basic status

Viewing alarms

To view alarms:

1 In the SSPA Manager window, click View in the Alarms frame.

The value of the parameter is indicated in the corresponding field.

The status of the parameter is indicated by the colour of the corresponding button. 
Active alarms are shown in red. The Legend frame shows the possible colours of the 
buttons and their meaning.

1 Click Close.

Viewing the RF level

To view the output RF level:

1 In the SSPA Manager window, view the output RF level in the RF Output frame, RF 
Level field.
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Viewing the mute status

To view the mute status:

1 In the SSPA Manager window, view the mute state in the SSPA Mute State frame.

Viewing the temperature of a PA module

To view the temperature:

1 In the SSPA Manager window, view the temperature in the Temperatures frame.

Viewing voltages

To view voltages:

1 In the SSPA Manager window, click View in the Alarms frame.

The value of the voltage is indicated in the corresponding field.

1 Click Close.

Setting the alarm notification

To set the alarm notification status:

1 In the SSPA Manager window, select Software Options from the Options menu.

1 Select the General tab.

1 In the Audible Alarm Notification frame, select the status that you want to use.

1 Click OK.

Option Description

On Your PC will beep at 1 second intervals when an alarm 
occurs

Off Your PC will not beep when an alarm occurs
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Acknowledging alarms

To acknowledge alarms:

1 In the SSPA Manager window, click View in the Alarms frame.

1 Click on the button that is alarming.

An �A� will appear on the button indicating that it has been acknowledged.

1 Click Close.

Clearing latched alarms

To clear latched alarms:

1 In the SSPA Manager window, click View in the Alarms frame.

1 Click Clear Alarms.

All alarms that are no longer active are cleared.

1 Click Close.

NOTE
If all current active and latched alarms are acknowledged, the audible 
notification of the alarm and flashing of text in the Alarms field will 
cease.
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Setting up Standard features

Setting the type of converter

The monitor and control interface determines how the SSPA will communicate with the 
converter. 

To set the type of converter to which the SSPA is connected:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Standard tab.

1 In the Converter Connection frame, select the type of converter that is connected to 
the SSPA.

1 Click Close.

Option Description

Codan SSPA is connected to a Codan 5700 or 5900 converter

Generic SSPA is used with a non-Codan converter
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Setting the maximum and minimum power alarm thresholds

To set the maximum and minimum power alarm thresholds:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Standard tab.

1 In the RF Level Thresholds frame, set the maximum and minimum thresholds that 
you want to use.

The RF Level Thresholds can be set in 0.5 dB steps.

1 Click Close.

Option Description

Minimum Sets the minimum threshold below which a non-urgent alarm will 
occur

5760:
5712H:
5940:

28.5 ≤ xx.x ≤ 52.0 in 0.5 dB steps
31.5 ≤ xx.x ≤ 55.0 in 0.5 dB steps
25.5 ≤ xx.x ≤ 49.0 in 0.5 dB steps

Maximum Sets the maximum threshold above which a non-urgent alarm will 
occur

5760:
5712H:
5940:

28.0 ≤ xx.x ≤ 51.5 in 0.5 dB steps
31.0 ≤ xx.x ≤ 54.5 in 0.5 dB steps
25.0 ≤ xx.x ≤ 48.5 in 0.5 dB steps

NOTE The threshold is disabled by setting it to D.
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Setting the address

To set the address:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Standard tab.

1 In the SSPA Address frame, set the address that you want to use for the connected 
SSPA.

The address must be an integer in the range 0�31.

1 Click Close.

The address of the SSPA is automatically updated in the Connection Address field in 
the SSPA Manager window.

Setting up Advanced features

Setting the amplifier shutdown mode

To set the amplifier shutdown mode:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Advanced tab.

1 Click Unlock to gain access to the parameters on the Advanced tab.

1 In the Amplifier Shutdown frame, select the mode that you want to use.

1 Click Close.

Option Description

On Faults detected in either the driver or the power modules are 
logged and both modules are shut down automatically

Off Faults detected in either the driver or the power modules are 
logged but both modules continue to operate, possibly in a 
degraded state
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Setting the method of temperature compensation

To set the method of temperature compensation:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Advanced tab.

1 Click Unlock to gain access to the parameters on the Advanced tab.

1 In the Temperature Compensation frame, select the type of compensation that you 
want to use.

1 Click Close.

CAUTION Although this temperature compensation method can be changed at any 
time, the user should not alter it without prior consultation with Codan.

Option Description

On Gain is automatically compensated over temperature 
(normal setting)

Off Compensation is fixed at the middle of the range 
(factory/special testing only)

Max Compensation is fixed to give the SSPA maximum gain 
(factory/special testing only)

Min Compensation is fixed to give the SSPA minimum gain 
(factory/special testing only)
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Setting the alarm style

To set the alarm style:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Advanced tab.

1 Click Unlock to gain access to the parameters on the Advanced tab.

1 In the SSPA Alarm Style frame, select the style that you want to use.

1 Click Close.

Setting the auxiliary alarm sense

To set the auxiliary alarm sense:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Advanced tab.

1 Click Unlock to gain access to the parameters on the Advanced tab.

1 In the Auxiliary Alarm Sense frame, select the status that you want to use.

1 Click Close.

Option Description

Latching Alarm is latched until it is cleared via the Clear Alarms 
button (recommended style)

Fleeting Alarm is logged as it occurs but is cleared as soon as the 
cause of the alarm is resolved

Option Description

High An alarm is generated if a high input signal occurs on the 
Auxiliary Alarm input pin of the CONTROL connector

Low An alarm is generated if a low input signal occurs on the 
Auxiliary Alarm input pin of the CONTROL connector
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Setting up Factory features

Setting the RF level table

To set the RF level table:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Factory tab.

1 Click Unlock to gain access to the parameters on the Factory tab.

1 In the RF Level Table frame, select the entry in the table that you want by using the 
scroll keys on the Scroll Table field.

The level and corresponding sensor level values will appear in their respective 
fields.

1 Edit the entries as required.

1 Click Close.

CAUTION Although the RF level table can be changed at any time, the user should 
not alter it without prior consultation with Codan.
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Setting the PIN diode table

To set the PIN diode table data:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Factory tab.

1 Click Unlock to gain access to the parameters on the Factory tab.

1 In the PIN Diode Table frame, select the entry in the table that you want by using the 
scroll keys on the Scroll Table field.

The attenuation level and corresponding DAC values will appear in their respective 
fields.

1 Edit the entries as required.

1 Click Close.

Selecting Maintenance mode

To place the SSPA into Maintenance mode:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Factory tab.

1 Click Unlock to gain access to the parameters on the Factory tab.

1 In the Mode frame, select Maint.

1 Click Close.

The operating state of the SSPA is shown in the SSPA Manager window, Operating 
State frame as Maintenance.

CAUTION Although the PIN diode table data can be changed at any time, the user 
should not alter it without prior consultation with Codan.

NOTE

You will need to select an appropriate entry from the PIN diode table 
if you intend to place the SSPA in Maintenance mode. The selected 
PIN diode point data is applied to the PIN diode attenuator while the 
SSPA is in Maintenance mode.
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Setting the temperature compensation points

To set the temperature compensation points:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Factory tab.

1 Click Unlock to gain access to the parameters on the Factory tab.

1 In the System Temperature Comp Points frame, select the entry in the table that you 
want by using the scroll keys on the Scroll Table field.

The compensation and corresponding temperature values will appear in their 
respective fields.

1 Edit the entries as required.

1 Click Close.

Setting the RF level temperature compensation points

To set the RF level temperature compensation points:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Factory tab.

1 Click Unlock to gain access to the parameters on the Factory tab.

1 In the RF Level Temperature Comp Points frame, select the entry in the table that 
you want by using the scroll keys on the Scroll Table field.

The compensation and corresponding temperature values will appear in their 
respective fields.

1 Edit the entries as required.

1 Click Close.

CAUTION Although this temperature compensation data can be changed at any time, 
the user should not alter it without prior consultation with Codan.

CAUTION
Although this RF level temperature compensation data can be changed at 
any time, the user should not alter it without prior consultation with 
Codan.
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Setting the thermal fan control mode

To set the thermal fan control mode:

1 In the SSPA Manager window, select SSPA Settings from the Options menu.

1 Select the Factory tab.

1 Click Unlock to gain access to the parameters on the Factory tab.

1 In the Thermal Fan Control frame, select the mode that you want to use.

1 Click Close.

Option Description

On Disables fan operation until the SSPA has warmed up to 
approximately 30°C

Off Enables fan operation at all times
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Recording the setup of your SSPA
To record the setup of your SSPA:

1 In the SSPA Manager window, select Save Snapshot (SSPA) from the File menu.

1 Enter appropriate descriptive information in the File Description field.

SSPA Manager uses the first 20 characters of this text as the filename.

1 Click OK.
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�����8 Operating the SSPA remotely

This section contains the following topics:

Remote communications protocol (60)
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Remote communications protocol
The communications protocol enables remote devices to control the SSPA, and also to 
determine its status. Typically, a remote device issues a command, the SSPA performs 
any actions necessary, then sends a reply. The reply will indicate the new status or 
operating condition. Checksum is used to validate commands and responses.

The protocol uses only the printable ASCII characters SPACE (0x20) to ~ (0x7E), where 
0xYY represents the hexadecimal value YY.
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Protocol format

Both transmit and receive messages fit the following format:

[Lead-in][Address][Message][Checksum][Terminator]

The characters used for the various message elements are given in Table 11.

Table 11: Characters used in message elements

Message element Character

[Lead-in] A control character with ASCII value 0x10 to 0x1F or the �{� 
character. Packets generated by the SSPA always use �{�.

[Address] Single alphabetic character representing the address of the unit. The 
character is (0x40 + ADDR), where ADDR is in the range 0x00 to 
0x1F (0 to 31). For example, �A� for address 1, �B� for 2..., up to �_� 
for address 31. Address 0 (or �@�) is reserved as a global address so 
all units will respond to and act on messages containing this 
address.

[Message] Up to 16 characters in the range �SPACE� (0x20) to �z� (0x7A).

[Checksum] Calculated from the address and message bytes of the transmission. 
The value of the single character checksum can be calculated as:

((SUM AND 63) XOR (SUM DIV 64)) + 32

where:

SUM is the modulo 256 sum of the address and message bytes
AND is the bitwise AND operator
XOR is the bitwise exclusive OR operator
DIV is the integer divide operator

Character values are ASCII.

This is equivalent to saying that the checksum is the 8-bit sum of the 
ASCII values of the address and message characters, with the two 
most significant bits of the result shifted down and exclusive ORed 
with the two least significant bits of the result. The value 32 
(SPACE) is added to make the result printable.

[Terminator] This character completes the transmission. Any control character 
(0x01 to 0x0F) or the �}� character may be used as a terminator. 
Packets generated by the SSPA always use �}�.
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Command and reply message format

A range of commands can be sent to the SSPA using the message format. A list of all 
these commands is given in Table 12 on the following pages.

If any of the characters in the command are lower case (0x60 through 0x7A), then the 
reply message will be suppressed. This function is useful when global addressing is used. 
Apart from this and the checksum calculations, the case of the message characters is 
ignored. 

The absence of a reply packet from the SSPA indicates that the command was not valid.

Except where specified, numeric values in commands do not require a �+� for positive 
numbers, and leading or trailing zeros are not required to expand numbers to the field 
sizes indicated.

The �+� is omitted on positive numbers in command responses from the SSPA. Where 
values normally have a decimal component (such as gain), the response from the SSPA 
will have a trailing zero after the decimal point (for example, G=�1.0).
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Table 12: Remote operation commands for an SSPA 

Command Transmit Reply Remarks

Display alarms A? A=abc...z Upper-case letters are used for active alarms, 
lower-case for cleared but latched alarms. A 
letter is not returned when the corresponding 
alarm is not active or latched.

If no alarms are active or latched, no 
characters follow the �=�.

Possible responses are:

A/a = 5 V rail low
B/b = 5 V rail high
C/c = 11 V (C-Band)/9.3 V (Ku-Band) rail 
low 
D/d = 11 V (C-Band)/9.3 V (Ku-Band) rail 
high
E/e = EEPROM corrupt or config changed 
(system still operational with default settings)
F/f = 14 V rail low
G/g = 14 V rail high
H/h = Power supply thermal warning
I/i = Internal processor error
J/j = �10 V rail low
K/k = �10 V rail high
L/l = RF level below Pmin threshold
M/m = RF level above Pmax threshold
O/o = Driver amp fail
P/p = Power Amp Module fail
R/r = 11 V LC rail low
S/s = 11 V LC rail high
T/t = Overtemperature module
X/x = Auxiliary alarm
Y/y = Failsafe alarm
Z/z = Simulated alarm

Test all (Self 
test)

ZA A=abc...z Responds with alarm state.

Simulate urgent 
alarm

ZZ A=abc...z Responds with alarm state.

Set amplifier 
shutdown mode

CS=E
CS=D

CS=SHUTDOWN 
ON
CS=SHUTDOWN 
OFF

Enables Amplifier Shutdown mode.

Disables Amplifier Shutdown mode.
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Display 
amplifier 
shutdown mode

CS? CS=SHUTDOWN 
ON
CS=SHUTDOWN 
OFF

Responds with current Amplifier Shutdown 
mode.

Display number 
of PIN diodes

CP? CP=n PIN DIODES Responds with number of PIN diodes, n, 
where n = 1 or 2.

Display unit 
type

CT? CT=60W C-BAND
CT=120W C-BAND
CT=40W Ku-BAND

Describes type of SSPA.

Display 
firmware 
version

CV? CV=0518A-01V6.0 Shows version number of firmware for the 
SSPA (example only shown).

Set auxiliary 
alarm active 
state

CX=L
CX=H

CX=ACTIVE LOW
CX=ACTIVE HIGH

Sets auxiliary alarm active state to low.
Sets auxiliary alarm active state to high.

Display 
auxiliary alarm 
active state

CX? CX=ACTIVE LOW
CX=ACTIVE HIGH

Describes active state of auxiliary alarm 
input.

Set alarm style CA=L
CA=F

CA=LATCHED
CA=FLEETING

Sets alarm style to latched.
Sets alarm style to fleeting.

Display alarm 
style

CA? CA=LATCHED
CA=FLEETING

Describes alarm style.

Display 
hardware 
platform

CH? CH=0969A Responds with hardware platform of 
connected SSPA (example only shown).

Set thermal fan 
control mode

CF=E CF=FAN CTRL ON Sets the thermal fan control to on, which 
disables the fan operation until the SSPA has 
warmed up to approximately 30°C.

CF=D CF=FAN CTRL OFF Sets the thermal fan control to off, which 
enables the fan operation at all times.

Display thermal 
fan control mode

CF? CF=FAN CTRL ON
CF=FAN CTRL OFF

Describes state of thermal fan control.

Table 12: Remote operation commands for an SSPA (cont.)

Command Transmit Reply Remarks
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Display status S? S=ACD...Z Letters correspond to full status, 
e.g. S=OCATR = on line, temperature 
compensated gain, audible alarm, RF mute 
off, EEPROM storage on.

Possible responses are:

A = audible alarm
B = mute is off but alarm has shut down 
amplifier
C = temperature compensated gain
D = mute is currently on via direct interface
F = EEPROM storage off 
H = maximum compensated gain
L = minimum compensated gain
M = maintenance mode
O = on line mode
Q = quiet mode
R = EEPROM storage on
S = standby mode
T = RF mute off
U = uncompensated gain
X = RF mute on
Y = unit is in LLO mode
Z = unit is in RLO mode

NOTE

The audible alarm and quiet mode 
responses are provided for 
software compatibility with other 
hardware versions of the 
equipment. These responses have 
no effect in the 5760/5712H and 
5940 SSPAs.

Online S=O S=ACD...Z Sets the operating mode (Online, Standby or 
Maintenance) and responds with complete 
status as shown for Display status command.Standby S=S S=ACD...Z

Maintenance S=M S=ACD...Z

Table 12: Remote operation commands for an SSPA (cont.)

Command Transmit Reply Remarks
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Temperature 
compensated 
gain

S=C S=ACD...Z Sets mode of temperature compensated gain 
(On, Off, Max or Min) and responds with 
complete status as shown for Display status 
command.Uncompensated 

gain
S=U S=ACD...Z

Maximum 
compensated 
gain

S=H S=ACD...Z

Minimum 
compensated 
gain

S=L S=ACD...Z

Audible alarm S=A S=ACD...Z Sets the alarm mode (Audible or Quiet) and 
responds with complete status as shown for 
Display status command.Quiet mode S=Q S=ACD...Z

NOTE

These commands and responses 
are provided for software 
compatibility with other hardware 
versions of the equipment. These 
commands and responses have no 
effect in the 5760/5712H and 
5940 SSPAs.

RF mute off S=T S=ACD...Z Sets the RF mute (Off or On) and responds 
with complete status as shown for Display 
status command.RF mute on S=X S=ACD...Z

EEPROM 
storage on

S=R S=ACD...Z Sets the mode of EEPROM storage (On or 
Off) and responds with complete status as 
shown for Display status command.EEPROM 

storage off
S=F S=ACD...Z

Remote REM S=ACD...Z Switches unit to Remote, Local or Local 
Lockout mode and responds with complete 
status as shown for Display status command.Local LCL S=ACD...Z

Local lockout LLO S=ACD...Z

Set unit address U=x U=x x = address in encoded format as follows:
@ = 0, A = 1, B = 2, C = 3,...Z = 26, [ = 27, 
\ = 28, ] = 29, ^ = 30, _ = 31.

The address will not be changed if the 
specified address is invalid.

Table 12: Remote operation commands for an SSPA (cont.)

Command Transmit Reply Remarks
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Display unit 
address

U? U=x x = address in encoded format as shown 
above.

Set gain G=−xx.x G=−xx.x Sets gain in dB. Allowed range is:
0.0 ≤ xx.x ≤ 20.0 in 0.2 dB steps.

If the specified gain is not a 0.2 multiple, the 
gain is set to the next lower 0.2 value. The 
gain will not be changed if the specified gain 
is out of range.

Display gain 
setting

G? G=−xx.x Responds with gain in dB.

Set Pmin RF 
threshold

T1=xx.x T1=xx.x
T1=D

Sets Pmin threshold in dBm. Allowed range is: 

5760: 28.5 ≤ xx.x ≤ 52.0 in 0.5 dB steps

5712H: 31.5 ≤ xx.x ≤ 55.0 in 0.5 dB steps

5940: 25.5 ≤ xx.x ≤ 49.0 in 0.5 dB steps

If the specified threshold is not a 0.5 multiple, 
it is rounded to the nearest 0.5 value. 
If xx.x < 28.5/31.5/25.5 respectively, the 
threshold is set to the minimum value.
If xx.x > 52.0/55.0/49.0 respectively, the 
threshold is set to the maximum value.

Disable Pmin RF 
threshold

T1=D T1=D Responds with D if facility is disabled.

Display Pmin RF 
threshold

T1? T1=xx.x
T1=D

Responds with Pmin threshold in dBm.
Responds with D if facility is disabled.

Set Pmax RF 
threshold

T2=xx.x T2=xx.x
T2=D

Sets Pmax threshold in dBm. Allowed range 
is:

5760: 28.0 ≤ xx.x ≤ 51.5 in 0.5 dB steps

5712H: 31.0 ≤ xx.x ≤ 54.5 in 0.5 dB steps

5940: 25.0 ≤ xx.x ≤ 48.5 in 0.5 dB steps

If the specified threshold is not a 0.5 multiple, 
it is rounded to the nearest 0.5 value. 
If xx.x > 51.5/54.5/48.5 respectively, the 
threshold is set to the maximum value.
If xx.x < 28.0/31.0/25.0 respectively, the 
threshold is set to the minimum value.

Table 12: Remote operation commands for an SSPA (cont.)

Command Transmit Reply Remarks
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Disable Pmax RF 
threshold

T2=D T2=D Responds with D if facility is disabled.

Display Pmax RF 
threshold

T2? T2=xx.x
T2=D

Responds with Pmax threshold in dBm.
Responds with D if facility is disabled.

Set interface 
mode

TX=0
TX=1

TX=0
TX=1

Sets interface mode to generic.

Display 
interface mode

TX? TX=0
TX=1

Responds with the interface mode.

Display 5 V rail 
voltage

V5? V5=x.xx Responds with reading in volts.

Display 11 V 
rail voltage

V11? V11=xx.x Responds with reading in volts.

NOTE
This command represents both the 
11 V rail in C-Band and 9.3 V rail 
in Ku-Band.

Display 11 V LC 
rail voltage

V11LC? V11LC=xx.x Responds with reading in volts.

Display 14 V 
rail voltage

V14? V14=xx.x Responds with reading in volts.

Display �10 V 
rail voltage

V�10? V�10=�xx.x Responds with reading in volts.

Display RF level VR? VR=xx.x Responds with reading in dBm. If RF level is: 

5760: < 28.0 dB

5712H: < 31.0 dB

5940: < 25.0 dB

the response will be �99.9.

Display 
temperature 
Module 1

VT? VT=±xxx Responds with reading in °C.

Display RF level 
(volts)

VER? VER=x.xx Responds with reading in volts.

Display 
temperature 
Module 1 (volts)

VET? VET=x.xx Responds with reading in volts.

Table 12: Remote operation commands for an SSPA (cont.)

Command Transmit Reply Remarks
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Programming notes

The following code fragments are provided for the benefit of system programmers to 
illustrate how to implement the communications protocol in a high level language.

/*
** comms_chk .. convert sum into checksum
*/
static byte comms_chk(byte ch)
{

return(((ch&0x3f)^((ch&0xc0)>>6)) + 0x20);/* calc checksum */
}

/*
** comms_send .. transmit formatted string over UART
*/

static void comms_send(char *str)
{

byte chk;
uart_putc(’{’); /* send lead-in */
chk = status.address+’@’; /* calculate address */
uart_putc(chk); /* send address */
while (*str)
{

chk += *str; /* calculate checksum */
uart_putc(*str); /* send character */
str++; /* next character */

}
uart_putc(comms_chk(chk)); /* send checksum */
uart_putc(’}’); /* send termination */
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�����9 Maintenance and fault finding

This section contains the following topics:

Faults (72)

Fault finding (75)

Cooling fans (77)

Storage and shipment (78)
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Faults
Three types of faults may occur:

� internal�urgent

� internal�non-urgent

� external

External faults are fixed as urgent and non-latching, i.e. auxiliary alarm.

Internal faults (both urgent and non-urgent) may be set to either:

� latched (fault condition remains even if the cause of the fault ceases)

� fleeting (fault condition ceases when the cause of the fault ceases)

To select the style of the alarm using the SSPA Manager software see page 53, Setting 
the alarm style. 

Urgent faults

An urgent fault switches the SSPA to the standby state and activates the Urgent and 
Summary Alarms (see Table 6 on page 30). Table 13 lists the conditions that cause 
urgent faults. For details on how the alarms are triggered see page 19, How the SSPAs 
work.

NOTE The setting selected (i.e. latched or fleeting) applies to both urgent and 
non-urgent alarms.

Table 13: Urgent fault conditions

Condition

Configuration changed

EEPROM corrupt

Failsafe error (factory purposes only)

Failure of the driver module 

Failure of the power module 

FET flange temperature is above 110°C (C-Band) or 90°C (Ku-Band) (see page 73, 
Overtemperature shutdown)

Internal processor error

Simulated alarm

Voltage rail out of limits
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If urgent faults are detected, the affected modules may be shut down.

Amplifier shutdown

Amplifier Shutdown mode determines how the driver and power module alarms operate.

When Amplifier Shutdown mode is enabled, faults detected in either the driver or the 
power modules will be logged and both modules will shut down automatically. 

When Amplifier Shutdown mode is disabled, faults detected in either the driver or the 
power modules will be logged, but the modules will not shut down. The SSPA will 
continue to operate but not at its full capacity. The extent to which the performance of the 
SSPA is reduced will depend on the actual fault. 

Amplifier Shutdown mode is enabled or disabled using the SSPA Manager software (see 
page 51, Setting the amplifier shutdown mode).

Overtemperature shutdown

When the SSPA is operated within the specified ambient temperature range, the 
measured FET flange temperature should stay below the threshold temperature of 105°C 
(C-Band) or 85°C (Ku-Band). A warning message is issued if the temperature reaches 
this threshold. The Maintenance and Summary alarms are also activated.

Typically this type of temperature problem is caused by fan failure or air flow 
restrictions and blockages. If the temperature reaches the shutdown threshold 
temperature of 110°C (C-Band) or 90°C (Ku-Band), the RF module will shut down and 
an urgent alarm will be generated.

Non-urgent faults

A non-urgent fault leaves the SSPA state unchanged and activates the Summary Alarm 
(see Table 6 on page 30). Table 14 lists the conditions that cause non-urgent faults. For 
details on how the alarms are triggered see page 19, How the SSPAs work.

CAUTION Continuous operation under these conditions may affect the reliability of 
the SSPA.

Table 14: Non-urgent fault conditions

Condition

FET flange temperature is above 105°C (C-Band) or 85°C (Ku-Band) (see page 73, 
Overtemperature shutdown)

Power supply thermal warning

RF power level is outside preset thresholds
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External faults

An external fault switches the SSPA to the standby state and activates the Urgent Alarm. 
Table 15 lists the only condition that causes an external fault. For details on how the 
alarm is triggered see page 19, How the SSPAs work.

NOTE External alarms are fleeting.

Table 15: External fault condition

Condition

Auxiliary alarm input
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Fault finding
The SSPA has been designed so that no routine maintenance or adjustments are required.

The SSPA is not field serviceable. If the SSPA is faulty, contact Codan immediately to 
obtain an RMA before returning the equipment. Failure to do so may result in any 
warranty being void.

Auxiliary alarm

The Auxiliary Alarm input is commonly used to detect an alarm generated by external 
equipment.

When an alarm is received:

� the SSPA is switched to the standby state

� the equipment that drives the Auxiliary alarm input may have faults

CAUTION The warranty on your SSPA will be void if the warranty seals are broken.

NOTE The Auxiliary alarm is fleeting.
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If technical assistance is required...

If technical assistance is required for any reason, please contact the Customer Service 
Engineering staff. For the most rapid response, please call the Codan office that is 
currently in office hours (see Table 16).

Outside of normal office hours, Codan has Customer Service Engineers on call to 
provide emergency technical assistance. They will either answer your call immediately 
or return your call as soon as possible. The contact phone numbers for after hours 
emergency technical assistance are also listed in Table 16.

If you are connected to a voice mail system when you call, please follow the instructions 
carefully, i.e. leave a brief, clear description of your problem and your name and contact 
phone number including the country code.

The Customer Service Engineer may request a snapshot of the setup of your SSPA to 
assist with fault finding. For information on how to take a snapshot see page 58, 
Recording the setup of your SSPA.

Table 16: Customer service contact numbers

Region Office hours contact 
number

After hours contact 
number

Email address

Asia/Pacific +61 8 8305 0311 +61 8 8305 0427 asiatech.support@codan.com.au

Europe, Middle East 
and Africa

+44 1252 717 272 +44 1252 741 300 uktech.support@codan.com.au

The Americas +1 703 361 2721 +1 703 366 3690 ustech.support@codan.com.au
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Cooling fans

The SSPA has two 14 V DC fans to cool the heatsinks. These are the only components 
within the SSPA that are subject to wear.

The DC power is supplied to the fans through DC feed-through capacitors. The fans 
blow air into the heatsink.

The fans should be replaced if the bearings become noisy. If overtemperature warnings 
occur (see page 73, Overtemperature shutdown), the fans should be checked for correct 
operation and the air passages should be checked for obstructions or restrictions. If a fan 
needs to be replaced, a spare fan may be ordered from Codan (power supply fan: Codan 
part number 32-F-10; power amplifier fan: Codan part number 32-F-30).

Replacing a fan

To replace a fan:

1 Switch off the AC supply to the SSPA.

1 Unscrew the screws retaining the fan cowling on the heatsink of the failed fan.

1 Desolder the two wires supplying power to the fan.

1 Unscrew the four M4 cap screws used to mount the fan.

1 Remove the fan.

1 Mount the replacement fan using the four M4 cap screws.

1 Resolder the fan supply wires to the DC feed-through capacitors, noting correct 
polarity.

1 Refit the cowling to the heatsink.

1 Switch on the AC supply to the SSPA.

1 Check that the fan is working and that the air is blowing into the heatsink and not 
away from it.

NOTE

If the Thermal Fan Control mode is set to On, the fans will not switch on 
until the FET flange temperature reaches 30°C. For information on the 
Thermal Fan Control mode see page 57, Setting the thermal fan control 
mode.
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Storage and shipment
The SSPA should be stored in a clean and dry environment. 

If an SSPA needs to be shipped, the blanking plate should be re-attached to the output 
waveguide flange of the SSPA. All connectors should have their protective caps in place. 
The SSPA should be wrapped in plastic, and placed in a durable shipping container or 
crate.

Sufficient shock absorbing material should be used to cushion the unit and prevent 
movement inside the container. The container should be sealed and marked �FRAGILE�.

CAUTION If the mounting kit is to be shipped with the SSPA, ensure that it is 
separated from the SSPA to prevent the SSPA from being scratched.
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�����10 Drawings

Drawing No. Description

0969D22 Interface Control Drawing (C-Band)

0969D23 Interface Control Drawing (Ku-Band)

0969D46 Mounting details of hub-mount SSPA 5760, 5712H and 5940

08-05301 Cable, Serial
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Appendix A Summary of parameters 
controlled by the SSPA Manager software

Table 17 lists the parameters of the SSPA that are monitored and controlled by the SSPA 
Manager software.

Table 17: SSPA parameters 

Parameter Monitored Control

Alarms 5 V rail low/high

11 V rail low/high (C-Band)
9.3 V rail low/high 
(Ku-Band)

14 V rail low/high

�10 V rail low/high

�11 V LC rail low/high

RF Level low/high

Over Temp Amp 1

Driver Amp fail

Power Amp 1 fail

Power supply thermal

Internal processor error

EEPROM/configuration

CE fail safe

Simulated

Auxiliary

View

Acknowledgment

Clear Alarms

Amplifier Shutdown On
Off

Audible Alarm Notification On
Off

Auxiliary Alarm Sense High
Low

Communications 
Connection

Connection Address
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Summary of parameters controlled by the SSPA Manager software
Communications Mode RLO REM
LLO

Converter Connection Codan
Generic

Data Rate Data Rate

Data Format Data Bits

Parity

Stop Bits

User Setting (Mute) RF On
RF Mute

Operating State Online
Standby
Maintenance (factory 
settings)

PIN Diode Table Attenuation Level

DAC Value

Scroll Table

RF Level Table Level

Sensor Level

Scroll Table

RF Level Temperature 
Comp Points

Compensation

Temperature

Scroll Table

RF Level Thresholds Minimum

Maximum

RF Output RF Level (output power)

RS232 Flow Control None
RTS/CTS

RS485 Half Duplex Control None/Auto
RTS

Table 17: SSPA parameters (cont.)

Parameter Monitored Control
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Summary of parameters controlled by the SSPA Manager software
Port Port

RS232
RS422/485

SSPA Address Address

SSPA Alarm Style Latching
Fleeting

SSPA Gain Gain Adjust

SSPA Mute State RF On
RF Mute (User)
RF Mute (Direct I/O)
RF Mute (Amp Module 
Fail)

System Temperature Comp 
Points

Compensation

Temperature

Scroll Table

Temperature Compensation On
Off
Min
Max

Temperatures PA Module 1

Thermal Fan Control On
Off

Table 17: SSPA parameters (cont.)

Parameter Monitored Control
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�����Appendix B SSPA Manager screens

Figure 2: Codan SSPA Manager window

Figure 3: Save Snapshot window
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SSPA Manager screens
Figure 4: SSPA Settings window�Standard tab

Figure 5: SSPA Settings window�Advanced tab
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SSPA Manager screens
Figure 6: SSPA Settings window�Factory tab

Figure 7: Software Options window�Communications tab
C-Band and Ku-Band Hub-mount SSPAs 5760/5712H and 5940 Reference Manual 87



SSPA Manager screens
Figure 8: Software Options window�General tab

Figure 9: SSPA Alarms window
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